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1 SUMMARY  

The Australian Institute of Marine Science’s Long-term Monitoring Program (LTMP) monitors benthic 

and reef fish assemblages on coral reefs, as well as crown-of-thorns starfish populations and other 

agents of coral mortality (bleaching, coral diseases and Drupella), using a variety of techniques.   

This document is Standard Operational Procedure Volume 12, produced by the Long-term Monitoring 

Program at the Australian Institute of Marine Science.  It details the standard procedures for three-

dimensional (3D) habitat reconstruction. 

Details for other surveying methods used by the LTMP including the sampling design (SOP 13), can be 

found in a series of Standard Operational Procedures published online:  

https://www.aims.gov.au/docs/research/monitoring/reef/sops.html 

2 INTRODUCTION 

Habitat structure is a key driver to resilient marine ecosystems; biodiversity, function, and the 

trajectory of reef communities are inextricably linked to the success of ecosystem engineers such as 

corals creating structure and thereby creating refuge for fish and other reef organisms (Gratwicke and 

Speight 2005a, Gratwicke and Speight 2005b, Harborne et al. 2012). There is increasing evidence that 

coral reefs’ resilience to climate change is related to a reef’s 3D structure (Bozec & Mumby 2015, 

Graham et al. 2015). For example, as coral reefs begin flattening after disturbances, fish that perform 

vital services to the coral reef have difficulties finding refuge and move away from the flattened 

sections of reef. 

Our ability to predict and manage the impacts of environmental change on reefs is impeded by a lack 

of data on the relationship between 3D structural complexity and biotic assemblages across spatial 

and temporal extents (Pygas et al. 2020). Digitising reefs of the GBR across space and time will help 

fill these gaps and advance our fundamental understanding of how to improve climate adaptation of 

coral reefs and reporting to management authorities (Calders et al. 2020). 

Current monitoring programs rarely measure the 3D structural complexity of coral reefs and 

therefore, are unlikely to improve understanding of related ecological processes. Thus, the lack of 3D 

data is limiting our understanding of reef status and trajectory in a warming ocean (Calders et al. 

2020). To quantify the 3D structural complexity of coral reefs across spatial and temporal scales, the 

benthic component of the LTMP produces 3D terrain reconstructions using close-range 

photogrammetry in conjunction with photo transects used to quantify benthic reef communities. 

https://www.aims.gov.au/docs/research/monitoring/reef/sops.html
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Figure 1. An AIMS diver collecting imagery along a transect for producing a 3D terrain reconstruction. 

This is accomplished using a paired-arrangement of Go-Pro cameras set apart by 40cm, the picture also 

shows the scale bar laid on the reef as a reference used to scale the 3D reconstruction (inside red rectangle). 

To estimate the structural complexity from transects, sequential images are collected along the first 

ten metres of each transect, using a dual camera set up (Figure 1), to recreate a high-resolution 3D 

terrain reconstruction of the reef substrate, here after referred to as 3D models (Figure 2). These 

models are a representation of the reef topography and area produced from overlapping two-

dimensional images using Structure from Motion (SfM) algorithms (Ferrari et al. 2016). SfM is a close-

range photogrammetric technique that finds correspondence between images and tracks common 

features (edges, shapes, etc) from one image to the next. The feature trajectories are then used to 

reconstruct their location in the 3D space and create a high-resolution (millimetric scale) 

tridimensional representation of the reef topography (Figure 2).  

To recreate the 3D models, the algorithm searches for common points (at pixel scale) in overlapping 

frames, matches them, and determines the position of the camera for each frame. The next step builds 

a dense point cloud based on the estimated camera positions and pictures (Ferrari et al. 2016). Points 

are then joined creating a 3D mesh made of triangular faces, over which the texture (colour 

information) of the 2D images on a pixel-by-pixel bases is overlaid to create a 3D model. Metrics are 

extracted either from the dense cloud or the 3D mesh, but the texture 3D model is useful for 

visualisation (Ferrari et al. 2016). 
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Figure 2. Sample 3D reconstruction from a transect section.  

This reconstruction is comprised by hundreds of thousands of points in the 3D space, from which multiple 

metrics of structural complexity can be extracted (i.e., 3D rugosity). 

Previous evaluations of the accuracy of 3D reconstructions using this methodology suggests that the 

technique can replicate the 3D structure of coral reefs within millimetres of error (Figueira et al. 2015). 

From these models, structural complexity is estimated by computing the rugosity index over the 3D 

meshes or point clouds, using the approach described in González-Rivero et al.  (2017) and Friedman 

et al (2012).  

The rugosity index is a measure of the deformation of a surface relative to its planar projection, and it 

is a common metric used to characterize the architecture of reef habitats (Graham and Nash 2013), 

where a value of 1 depicts a perfectly flat surface and the index increases with the complexity of 

surface convolutions.  

While rugosity is common metric to represent structural complexity of coral reefs, additional metrics 

are also derived from these models to capture a more complete picture of the habitat structural 

complexity and its changes over time. These include curvature, range of heights, slope, among others. 

This Standard Operational Procedure describes the methodology for sampling and data analyses 

presently used by the LTMP at AIMS to recreate the 3D models of reef substrate and derive the 

structural complexity metrics of these systems (Figure 3).  

Consequently, some aspects of the manual are specific to the equipment used in this program.  This 

Standard Operational Procedure is also intended to act as a guide for other users who wish to use 

photography to map and monitor habitat structural complexity of benthic communities on coral reefs. 
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Figure 3. A visual representation of the outputs to estimate structural complexity of coral reefs using 

photogrammetry and 3D data analysis. 

 A) Top view of a 3D reconstruction from a transect; B) High-resolution bathymetry generated from the 3D 

reconstruction; and C) Interpolated rugosity index estimated at specific point locations across the 3D 

reconstruction.  

A B C 
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3 HABITAT RECONSTRUCTION 

The following standard procedures are used by LTMP for collecting images to make 3D habitat 

reconstructions of sessile benthic communities and quantifying structural complexity.  They are 

specific to the objectives of the program but may be easily modified to satisfy other research 

objectives. 

3.1 Personnel 

A minimum of three people is required for the collection of 3D habitat data using this technique. One 

person is required to lay the tape and place scale markers evenly along the transect. The second 

person will follow and capture both sides of the 10m transect. The third person is required to remain 

in the boat as a divers’ attendant and surface support. 

LTMP 3D habitat surveys are conducted concurrently with surveys of reef fishes (Emslie and Cheal, 

2018), juvenile corals (Jonker et al 2020), and coral disease and other agents of coral mortality along 

the same transects (Miller et al 2020). 

3.1.1 Field Equipment 

To make 3D habitat reconstructions, the following list of equipment is required in the field.  

• 1 x waterproof case with: 

o 2 x GoPro Hero 6 cameras  

o 2 x 128 GB memory cards  

o Battery chargers 

o SD card reader 

o 2 x GoPro underwater housings,  

o Manuals for camera and housing 

o Set of QR code transect identifiers (Figure 4) 

o Transect markers (GCP) for habitat reconstruction (See Figure 6) 

o Red filter for each Go Pro. 

• 1 x metal bar (~ 0.6 m) and butterfly screws to attach Go Pros 405mm apart. 

• Laptop 

o Reefmon database data entry software (not available yet) 

o Application for sorting images (see Data Management section 4) - not necessary but 

will save you time. 

o Agisoft Metashape (If using a network licence, this needs to be checked out via ICT to 

the user for the length of the field trip)  

• External hard drive to store and back up images and data (2 x 4TB for each sampling year). 
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Figure 4. A set of QR code transect identifiers.  

These are used by the LTMP to allow automatic sorting of images on the camera’s SD card from the photo 

transects into their respective transects. 

3.2 Equipment Preparation 

3.2.1 GoPro Hero Camera Settings 

1) Check each camera to ensure the date and time are correct.  

2) Ensure the memory cards have been downloaded and erased prior to camera set up and the 

batteries are fully charged.  

3) Leave all settings to default except for: 

a) Auto rotation fixed to “down”. 

b) Default mode to time lapse photos at 0.5s intervals (Camera with a clock symbol ).  

c) Field of view set to “Linear 

3.2.2 GoPro Hero 6 Housing 

1) Check both sides of the housing window for the lens are clean. Use a lens cleaning tissue or the 

lens cleaning fluid with the soft lens cleaning cloth. 

2) Wipe your finger around the silicon O-ring for the housing and visually inspect to ensure there 

is nothing on the O-ring. Do not use silicone grease on GoPro housings. 

3) Close the housing and secure the clip.  
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3.3 Camera Set Up 

To collect the habitat reconstruction data the GoPro cameras should be mounted 405 mm apart onto 

a stainless-steel bar, through predrilled holes with butterfly nuts. If benthic surveys using the photo 

transect method are done concurrently, the photo-transect camera (Nauticam housing) should be 

placed in the middle of the bar and the GoPro camera lenses should be facing the direction of the 

transect camera (Figure 5). When tightening the butterfly nuts, ensure that the spring washer is on 

the same side of the bar as the butterfly nut (i.e., opposite side to the GoPro camera). 

 

Figure 5. Overview of the camera set up where GoPro cameras are used for recreating and measuring the 

habitat structural complexity.  

The “transect camera”, in the middle is used to collect the high-definition images for estimating benthic 

composition and specific details can be found in SOP 10, Surveys of benthic reef communities using 

underwater digital photography and counts of juvenile corals.  

3.4 Field Sampling Procedure 

In suitable light conditions, typically in horizontal visibility greater than 5 m, images are taken along 

the first 10 m of each transect, with the cameras held approximately 1.5 – 2.0m above the reef 

substrate. Before commencing each transect, lay three, or more, scalebars at approximately even 

intervals along the transect. A scalebar is comprised of a pair of unique Ground Control Points (GCP), 

with a fixed, known distance between the centres of the two GCPs, (Figure 6). A GCP is a pattern 

recognised by Metashape and can be printed by clicking on Tools > Markers > Print Markers. It is 

important to ensure the markers are not scratched or damaged before use, if they are damaged, 

replace them.  

Each individual GCP is assigned an identifying number (Figure 6), it is critical that these numbers are 

used only once per transect as a repeated GCP will cause an error in the reconstruction of the transect. 

The LTMP uses scalebars, which are created from predesignated pair of GCPs with a known, fixed 

distance apart (150mm), the scalebars are used by Metashape to assign scale to the 3D reconstruction 

and all features within it (i.e., corals). It is imperative that the camera can capture unobstructed images 

of both GCPs facing upwards on each scalebar and equally, it is also important that the scalebars are 

laid where they are unlikely to be repositioned by surge or currents, particularly if there are to be 
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multiple passes capturing images over the same area. If a marker moves during imaging, that transect 

needs to be re-imaged. 

The following steps describe how to conduct the transect, while completing these steps, the diver 

should attempt to maintain a consistent altitude (1.5 – 2.0 m) above the substrate and swimming 

speed with the entire transect (first 10 m of each LTMP benthic transect) which should take 

approximately one minute. 

1) Before commencing the transect, ensure that both GoPros are parallel to each other while the 

dive buddy places all three scalebars within the first 10 metres of the transect. 

2) The GoPro cameras are setup to automatically turn on to the correct settings, once switched 

on, press the “record” button (If the mode button is pressed by accident, simply turn the GoPro 

off and back on).  

3) Hold the QR code tag for the specific transect in front of each GoPro for 3 seconds. 

4) To begin the transect, swim along the righthand side of the transect with the cameras capturing 

images 1.5 m above and parallel to the reef substrate keeping the transect tape just visible in 

the left-hand side of the view finder of the left-hand camera. 

5) Once the outward leg of the transect has been completed, slowly turn around and continue 

photographing from the left-hand side of the transect, keeping the transect tape just visible in 

the left-hand side of the view finder of the left-hand camera. 

6) Upon completion of the transect, stop both GoPro cameras and begin the photo-transect survey 

as described in SOP 10. 

 

Figure 6. A scalebar with the yellow arrows denoting what Metashape considers to be the centre points of the 

two GCPs.  

The distance between the two centre points is known and can provide scale to the 3D models and by-products, 

the scale bars used by LTMP are typically 150mm between these two points. The blue arrows denote the 

identifying numbers of each GCP, it is important that none of the GCPs used on the transect have matching 

identifying numbers. 
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4 FIELD DATA MANAGEMENT 

Many of the processes in Metashape are internally scripted, so it is important the images from the 

camera are organised into folders using a standardised system to allow the program to function 

properly. For LTMP data, the images should be sorted into a folder structure identical to the photo-

transects described in SOP 10 (Jonker et al. 2020), i.e., the images are sorted first by reef, then into 

their corresponding sites and transects (e.g., ReefName/SiteNumber/TransectNumber). 

4.1 Download Images to Field Computer 

1) Create a folder labelled unsorted, this is where you will download all images from the cameras 

into (do not download from cameras yet). 

2) Within the unsorted folder, create a folder labelled according to the reef surveyed (e.g., 

THETFORD REEF).  

Note: Make sure the name of the reef folder corresponds to the name in the database, a list of the 

reef names as they appear in the database taken on each cruise. 

4.2 Manually Sort Images 

Typically, the LTMP uses a folder labelled “unsorted” to use as a staging point to sort the images from 

the photo-transects into their respective transects as described in SOP 10 (Jonker et al 2020). To 

remain consistent, this SOP will mirror the methods described in SOP 10 where possible. 

1) Within the reef folder, create a folder called LC (left camera) and RC (right camera). 

2) Copy the images from SD cards of the left-hand and right-hand cameras into the LC and RC 

folders. 

3) While the images are copying, create a folder for each transect of each site labelled 

“SiteXTranX” as shown in Figure 7. Folder structure for transects of reefs with each folder name 

corresponding to each transect. Keeping this format is important due to the scripts in 

Metashape being mapped to these folder names. below.  

*Tip, there is pre-named set of folders on the backup drives underneath the “folder structure” 

directory, this will save you from individually creating and naming each folder. 

4) Open the LC folder and sort the image files by the date they were modified, from earliest to 

latest. This can be sorted by clicking on the “Date Modified” tab up the top of file explorer in 

Window and clicking it twice. 

  

There are 2 alternative methods to sort images (manually or semi-automatically using python 

code), regardless of which of the two you use, images first need to be copied into the computer 

following the steps and structure explained in this section. Then apply either of the 2 sorting 

methods explained in sections 4.2 or 4.3. 
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5) Because the images for the habitat reconstructions are collected at the beginning of the LTMP 

transects at 0.5 second intervals, there is an obvious time gap between the images from each 

transect. In Figure 8 it can be seen that the timestamp in the Date modified column of the last 

selected file is 2:38 PM, and the first of the non-selected files is 2:52 PM. These time stamps can 

be used to sort the images into their respective transect folders shown in Figure 7. 

6) Repeat steps 4 and 5 for the RC folder. 

7) Upon completion, look in each of the transect folders, locate an image showing the QR code 

and ensure that the site and transect number on the QR tag correspond with the folder the 

images are located in. 

8) Delete the empty folders for any transects that were not completed (images not captured) and 

make a note in the field log metadata about any incomplete data. 

9) When the images have been filed into their corresponding transect folders and checked, the 

final step is to back them up onto both the external benthic backup hard drives (creating 2 

identical copies). All images from the trip, including benthic photo-transect, images for media 

use, and images for habitat reconstructions are backed up on the external hard drives within 

the relevant subfolder under the [CRUISE_CODE] folder. For habitat reconstructions, the folder 

“3D Transects” is where the backed-up images for the habitat reconstructions are located. 

Figure 7. Folder structure for transects of reefs with each folder name corresponding to each transect.  
Keeping this format is important due to the scripts in Metashape being mapped to use these folder names. 
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Figure 8. Image files showing a noticeable time difference between the selected files and the non-selected 

files.   

In this case there are fourteen minutes between the selected (2:38 PM) and non-selected files (2:52 PM) 

indicating the end of one transect and the beginning of the next. Such time stamps can be used to sort the 

images into their respective transect folders shown previously in Figure 7.  

4.3 Use Python App to Sort Images from Command Prompt 

Follow these steps to organise GoPro time-lapse images for 3D reconstruction into 

SiteNumberTransectNumber folders (details of each step below under 4.2.1): 

• Setup the application (First Time Use Only). 

• Sort images: This step organises all the images from the Left (LC) and Right (RC) cameras, in 

each Reef folder, into subfolders using a time gap to distinguish transects and sites. Then, it 

automatically recognises the QR codes in the images and renames transect subfolders for 

each camera folder.  

• Review and manually rename folders if needed: Manually review subfolder names and 

allocate names to those where QR was not recognised. 

• Merge renamed transect folders from each camera: Automatically merge subfolders from 

Left and Right Camera. 
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4.3.1 Set Up Application (First Time Use Only)  

This step will only need to be completed once per computer to set up the python application required 

to sort the images (step 2 and 4). Please follow these steps: 

1) Make sure you got a Git client installed. Otherwise check here for details. 

2) Clone the following GitHub repository to your local hard drive: 

https://github.com/AIMS/reef3D.git   Check this webpage for details if you need more 

information about cloning repos in GitHub Desktop. 

3) Install python if not available in your computer and restart your computer. Check more info 

here.  

4) Open the Command prompt (Windows) or terminal (MacOS). In Windows, go to the start 

menu and type: cmd 

5) Follow the next steps from the cmd: 

a. Change directory to where you cloned the GitHub repository by typing in the cmd 

(step1) 

b. Change directory to image_sorter by typing: 

c. Install python dependencies by typing: 

4.3.2 Sorting Images 

This step will run a custom-made Python function to group images from left (LC) and right (RC) cameras 

into transects. This script uses a time gap of three minutes between images to identify a new transect 

and will sort them into sequentially numbered folders (i.e., 1,2,3...). It will then attempt to recognise 

the QR code from the first 20 images in each transect and label the folders accordingly. 

cd  C:\folder\where\you\have\installed   

Example: “cd C:\Users\xxx\Documents\gits\reef3D\” 

cd PyToolbox\image_sorter 

pip install -r requirements.txt 

*Trouble-shooting tip: to check if you need to “Add Python to the PATH Environmental 

Variable”, go to command prompt and type “python” - if you get an error saying “'python' is not 

recognized as an internal or external command, operable program or batch file” then you need 

to add Python to the PATH Environmental Variable, see instructions here. If you need to add it, 

you may need to contact AIMS helphub to get permission to access the Advanced System 

Settings. Before contacting them, you can try connecting via VPN and using Elevate in your 

computer.  

Alternatively, you can also add python to the Path Env variable through command prompt by 

typing: 

setx PATH "%PATH%";C:\Python38\Scripts 

https://www.techrepublic.com/article/how-to-install-github-desktop/
https://github.com/AIMS/reef3D.git
https://docs.github.com/en/free-pro-team@latest/desktop/contributing-and-collaborating-using-github-desktop/cloning-and-forking-repositories-from-github-desktop
https://realpython.com/installing-python/
https://www.pythoncentral.io/add-python-to-path-python-is-not-recognized-as-an-internal-or-external-command/
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1) Copy the images from SD cards of the left-hand and right-hand cameras into the 

corresponding Reef folder (all images into a single folder). Repeat this for each reef of the 

day. 

2) To begin sorting the images, open the command prompt / terminal and change directory to 

the folder where you cloned the reef3D GitHub repository: 

3) Change directory to image_sorter: 

4) Now, select the Reef folder you want to organise and identify the prefix you want to assign 

to these images. The Reef folder contains all the left and right camera images from transects 

in each Reef and cruise code. If you are sorting images after they have been copied from the 

field computer to the 3D-LTMP shared folder in the AIMS server (you are not in the field but 

in the lab), the folder will be located in the 3D-LTMP shared folder in: 

Note: Make sure the name of the reef folder corresponds to the name in the database, a 

list of the reef names as they appear in the database taken on each cruise (a list of reef 

names as they appear in the database is taken on each cruise). 

The prefix for the image is the string used to rename all the images to follow this naming 

convention: 

[REEF NAME]_[VISIT NO]_[IMAGENUMBER].JPG 

[IMAGE NUMBER] is automatically generated, so the prefix entered in the function below 

should be: [REEF NAME]_[VISIT NO]. For example: AGINCOURT REEF (NO 1) 

5) Run the file sorter from the windows terminal: 

*Tip: Please note that arguments (reef folder and prefix) are quoted (" "). Otherwise, the 

function will not recognise names with blank spaces. 

cd  C:\folder\where\you\have\installed  (e.g., cd 

C:\Users\xxx\Documents\gits\reef3D\) 

cd PyToolbox\image_sorter 

\\tsv-isilon1\3D-LTMP\data\LTMP\[PROJECT]\[SURVEY YEAR]\[CRUISE CODE]\. 

Example: \\tsv-isilon1\3D-LTMP\data\LTMP\RAP\201920\QA\AGINCOURT REEF (NO 1). 

python3  step1_sortRename.py "[REEF FOLDER]" "[PREFIX]" 

Example: 

python3 step1_sortRename.py 

"/media/pearl/3d_ltmp/data/LTMP/RAP/201920/QA/agincourt reef (no 1)/" 

"AGINCOURT REEF (NO 1)" 
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4.3.3 Review and Manually Rename Folders: 

Once the software has finished, review the images contained in these folders to ensure the sorting 

process was successfully completed without errors. 

Occasionally, not all the QR codes are identified by the scanning software, where this is the case, the 

script will have kept the sequential numbering of the transect without inserting the proceeding 

Site#Tran# label shown in Figure 9. Where this is the case, open the folder and find an image capturing 

a QR tag and manually rename the folder to correspond with the transect listed on the QR tag. 

 

Figure 9. Showing folders containing images labelled by the software.  

These are labelled by their sequence number followed by the site and transect numbers where it has 

successfully read the QR tag for the corresponding transect, where it is unable to read the QR tag it will only 

label the folder as the sequence number in this this figure by the folder “7” seen in the highlighted folder on 

the bottom. 

Upon reviewing and renaming the transect folders, remove the numbers preceding the Site#Tran# to 

be consistent with the folders shown in Figure 7. Folder structure for transects of reefs with each 

folder name corresponding to each transect. Keeping this format is important due to the scripts in 

Metashape being mapped to these folder names. 

4.3.4 Merge the Renamed Transect Folders from each Camera. 

This script will match folders from the Left and Right Cameras (LC and RC folders) making them suitable 

to process in Metashape. Upon confirming that all images have been correctly sorted into their 

respective transects, delete the LC and RC folders if they have been created. 

To merge folders run this script from the same terminal window as above: 

**IMPORTANT NOTE**: Deleting the RC and LC folders is irreversible! Ensure the sorting and 

renaming is correct before deleting these folders (as per step 4.3.3). 

4.3.5 Troubleshooting 

Consider the following tips when working from the HPC: 

3d_ltmp is mounted in: 

python3 step2_mergeCameras.py  

Example: "/media/pearl/3d_ltmp/data/LTMP/RAP/201920/QA/agincourt reefs (no 1)/" 

/mnt/isilon 
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You need to load the python3 module. For this go to terminal and type: 

If you get the following error: “Import Error: Unable to find zbar shared library”. Do this: 

4.3.6 Using Image Sorter on the HPC 

Login into the HPC interactive and Launch a XTERM session: 

https://hpc-interactive.aims.gov.au:3443/  

Pull git repository to your home directory. From terminal, change directory to where you want to 

install this repository [FIRST TIME ONLY] 

NOTE: it will ask you for your username and password for GitHub 

Load the python module 

Change directory to the image sorter folder where you install the GitHub repository: 

Install dependencies (libraries required) 

Isilon is mounted in the following directory. Use this directory to locate the folder you want to sort: 

*Tip: You must have an AIMS git hub account to do this (Access the AIMS/reef3D repository), if you 

don’t have one please contact Murray Logan at m.logan@aims.gov.au 

  

module load python/3.5.1 

sudo apt-get install libzbar-dev libzbar0 

cd ~/Documents 

mkdir gits 

git clone https://github.com/AIMS/reef3D.git  

module load python/3.5.1 

cd ~/Documents/gits/reef3D/PyToolbox/image_sorter 

pip install -r requirements.txt 

/mnt/isilon 

Example: /mnt/isilon/data/LTMP/RAP/201920/QA/ 

https://hpc-interactive.aims.gov.au:3443/
mailto:m.logan@aims.gov.au
https://github.com/AIMS/reef3D.git
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5 PROCESSING DATA (3D MODELLING) 

Images are processed into 3D reconstructions and 2D orthomosaics using Agisoft Metashape 

Professional (Autodesk, Inc. Version 1.5.2, note this is not the latest version – do not update the 

version if prompted). The following steps describe the process to generate the 3D models of the reef 

substrate to estimate the metrics of structural complexity (e.g., rugosity). The steps below are divided 

into three workflows: 

• Pre-processing software licensing and connectivity set-up 

• Processing data – from images to 3D models and 2D orthomosaics 

• Metric extraction 

**NOTE ON PROCESSING**: We have scripted most of the settings for image processing to ensure 

consistency and automatic image processing which allows for efficient batch processing, for instance, 

you can line up 15 chunks and leave them processing overnight. We have compiled the 12 scripts for 

processing in one file called “LTMP_process_batch.xml”. We will refer to this file as “the batch file” 

several times throughout these instructions, the 12 processing steps will be run in groups, rather than 

all together, to implement a few manual quality checks (Figure 14). The instructions below assume 

you are connected to the VPN and internet if you are planning to process while in the field you 

should save the batch file (LTMP_process_batch.xml) and associated script files locally before you 

go to the field. 

5.1 Pre-processing Data Set Up 

There are three ways to process the data with the most suitable being dependent upon the speed of 

your internet connection. While Network processing is preferred, it will not always be possible, hence 

we have included instructions for all the options. These three processing alternatives are defined by if 

data is processed remotely (using AIMS processing network – preferred option) or locally (on your 

own computer), and if locally determine if you will have internet and VPN connectivity (Figure 10). 

 

Figure 10. A flowchart showing the three alternative options for processing data from images to 3D 

models and 2D orthomosaics.  

Which way you choose will depend on the task at hand and internet connectivity. Each option 

requires slightly different pre-processing set up.  
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1) Process data using AIMS virtual desktop and network of processing servers (preferred option 

as it is a lot faster and more efficient): 

a. Connect to the internet and the AIMS network using Cisco AnyConnect mobility 

services App (VPN) and your credentials. 

a) Launch the "Remote Desktop Connection App" from Windows and Input the terminal 

address in the "Computer" field (tsv-termsrv01.aims.gov.au). Add your AIMS username by 

clicking "Show Options" and connect. 

b) From within the virtual desktop, add a network drive to map the data repository in this 

computer. For this use the following address (here are instructions on how to map a network 

drive in Windows 10): \\tsv-isilon1\3D-LTMP  

c) Open Metashape Pro and check that for the computer you are using, Metashape has Network 

Processing enabled (that it is connected to the server) by hovering mouse over symbol on the 

bottom right corner of the Metashape window. If it is not connected to server go to 

Tools>Metashape Preferences, a window will pop-up, select the 3rd tab on the top menu 

“Network” and ensure the settings look like shown in Figure 11. You should check that: (1) the 

“Enable network processing” box is selected, (2) the “Host name” and “Port number” are 

correct (host name = metashape-qmgr.aims.gov.au, port number = 5840), and (3) the root is 

set to the letter where you mounted Isilon onto your drive (normally “Z”). 

4) Process data using your computer and the AIMS network of processing servers (this is the 

best option if you want to maximise processing speed but also want to visualise models – as 

the remote desktop connection to the server can have slow rendering speeds, so a local 

computer will perform better for model visualisation and manipulation) – the first 2 steps 

(install software and license) are a onetime only step, so after doing them for a given 

computer you can skip to step 5.2: 

a) Install Agisoft Metashape Pro in your computer from this link.  

b) The first time you use a given computer you will need to add the server license file to 

the folder where Metashape has been installed. Click here Server License to download 

and save the Metashape license file, move the file to the folder in the computer where 

Metashape has been saved (normally in C:\Program Files\Agisoft\Metashape Pro).  

Skip this step in the future. 

c) Connect to the internet and AIMS VPN before opening Metashape for the license to 

work, if you are not connected to the VPN Metashape will open but it will prompt you 

to activate the license. 

d) Add a network drive to map the data repository in this computer. For this use the 

following address (here are instructions on how to map/mount a network drive in 

Windows 10 (https://www.dummies.com/computers/pcs/mapping-a-network-drive-

on-your-windows-10-pc/)): \\tsv-isilon1\3D-LTMP  

e) Open Metashape Pro and check that for the computer that you are using Metashape 

has Network Processing enabled (that it is connected to the server) by hovering mouse 

over symbol on the bottom right corner of the Metashape window.  

  

file://///tsv-isilon1/3D-LTMP
https://www.agisoft.com/downloads/installer/
https://aimsgovau.sharepoint.com/sites/3Dmodelling/Shared%20Documents/General/server.lic
https://www.dummies.com/computers/pcs/mapping-a-network-drive-on-your-windows-10-pc/
file://///tsv-isilon1/3D-LTMP
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If it is not connected to server go to Tools>Metashape Preferences, a window will pop-

up, select the 3rd tab on the top menu “Network” and ensure the settings look like 

shown in Figure 11. You should check that: (1) the “Enable network processing” box is 

selected, (2) the “Host name” and “Port number” are correct as in Figure 11 (host 

name = metashape-qmgr.aims.gov.au, port number = 5840), and (3) the root is set to 

the letter where you mounted Isilon (normally “Z”). 

 

Figure 11. An example of correct settings to enable network processing for image processing 

in Agisoft Metashape. 

5) Process data locally without internet access. You need to do 4 things while online to enable 

off-line processing: 

a) Install Metashape Pro in the field computer: follow step 2) a. above. 

b) Copy the server license to the field computer: follow step 2) b. above. 

c) 5.1.3.3. Check out a license (from within Metashape) while connected to the internet 

and VPN borrow a license by Opening Metashape and going to Help > Activate Product 

and clicking on “Borrow License” in the pop-up window, then enter the number of 

days you will be offline and request the license. 

d) Copy the folder [\\isilon\3d_ltmp\scripts] to the root of C:\ 

e) To store the images, create the folder structure C:\data\LTMP\PROGRAM CODE\YEAR 

CODE\CRUISE CODE\REEF NAME e.g. C:\data\LTMP\RM\202021\QE and store the 

images sorted into transect folders there. 

f) Use the processing batch file LTMP_process_batch_LOCAL, this can be found in: 

[C:\scripts\batch_jobs\LTMP_process_batch_LOCAL]. 

g) The Processing Status Spreadsheet can be downloaded from here. 

  

https://teams.microsoft.com/l/file/BEA5D44F-F009-4B16-A26B-81D614B43D4E?tenantId=e054a73b-40dc-4ae3-9fce-60c537aa6fac&fileType=xlsx&objectUrl=https%3A%2F%2Faimsgovau.sharepoint.com%2Fsites%2F3Dmodelling%2FShared%20Documents%2FGeneral%2F3D_Processing_status_monitoring_LTMP_AIMS.xlsx&baseUrl=https%3A%2F%2Faimsgovau.sharepoint.com%2Fsites%2F3Dmodelling&serviceName=teams&threadId=19:393b6870a3e141c98a95a8a291611ba1@thread.tacv2&groupId=851a9282-cdc6-46b7-bb33-d751de57e84d
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5.2 Processing Data 

1) Open the Processing Status Spreadsheet in teams if you are connected to the internet, or 

from your computer if you are in the field. 

2) To start processing images, open Metashape Pro and Go to Workflow > Add Folder, then 

navigate to and select the folder corresponding to the reef you want to process (e.g. 

Chinaman). This will import all images from each transect into a separate “Chunk” or folder 

within Metashape.  

3) Rename each Chunk as per Reefmon reef name in front of the site and transect numbers 

(i.e. “CHINAMAN_Site1Tran1”), do this for each of the 15 chunks. Check there are 15 chunks 

(Site 1-3, Transects 1-5) imported, otherwise note it in the Notes on your processing status 

spreadsheet.  

4) Save the project in the following folder (if connected to the VPN): 

[\\isilon\3d_lmtp\projects\[PROGRAM]\[YEAR]\[REEFNAME]. If not connected to the VPN 

save the project within the corresponding reef folder as per LTMP naming and folder 

structure, explained in section 4 (Field data management). 

5) Click on Workflow> Batch Process and load the following batch script 

[\\isilon\3d_ltmp\scripts\batch_jobs\LTMP_process_batch]. In the pop-up window shown 

in Figure 12 there are 13 steps, select steps 1-6 by ticking the boxes on the left of each of 

step and click “OK”. If Network Processing is enabled a pop-up window will ask if you want 

to process it over the network, click yes unless you have no internet or VPN connection. 

Below is a brief description of each process number: 

a) Process #1:  Run script: Load calibration parameters for camera lens used 

for the survey: Choose the following calibration file: 

“isilon\calibration\calibration.xml" 

b) Process #2:  Run script: Remove images with quality below the 0.5 threshold 

c) Process #3:  Detect markers: automatically identify the markers (GCPs) 

d) Process #4:  Run Script: Set distance between the markers. (Run script) 

e) Process #5:  Aligns Photos: Detects matching features between images 

before aligning them relative to each other.  

f) Process #6:  Run script: Align images that didn’t align in the first pass. (Run 

script) 

https://teams.microsoft.com/l/file/BEA5D44F-F009-4B16-A26B-81D614B43D4E?tenantId=e054a73b-40dc-4ae3-9fce-60c537aa6fac&fileType=xlsx&objectUrl=https%3A%2F%2Faimsgovau.sharepoint.com%2Fsites%2F3Dmodelling%2FShared%20Documents%2FGeneral%2F3D_Processing_status_monitoring_LTMP_AIMS.xlsx&baseUrl=https%3A%2F%2Faimsgovau.sharepoint.com%2Fsites%2F3Dmodelling&serviceName=teams&threadId=19:393b6870a3e141c98a95a8a291611ba1@thread.tacv2&groupId=851a9282-cdc6-46b7-bb33-d751de57e84d
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Figure 12. The list of processes to create 3D reconstructions and ortho-mosaics from 2D images. 

These steps are sequential but are ran in groups to ensure the quality of the product. Processes 1-

6 are initially executed in the processing batch file, upon completing quality checks described later 

in the document, processes 7-9 are then executed. 

6) Once processes 1-6 have completed (Figure 12), and the images have been aligned, ensure 

that on each transect, at least six GCP markers (3 scalebars) were detected and each marker 

has ten or more verified projections. The number of markers can be checked by expanding 

the Markers folder and the number of projections of projections for each marker can be 

checked by clicking on its corresponding target number shown in Figure 13 below. 

 

Figure 13. Showing the six markers and the number of projections for the selected marker 

underneath. 
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7) If less than 6 markers were detected by the script in step 5c), you will need to manually add 

the undetected GCPs and verify their placement on the images for at least 10 images by: 

a) Go to View>Photos this will show you a window with all photo thumbnails, on the top 

menu of the Photos window use the Change view>Large button to make thumbnails 

large and quickly find images with the undetected marker, double click on one image 

with the undetected marker (Figure 14). An alternative method is that if Metashape 

has detected the missing markers paired marker on the scalebar, simply right click on 

the paired marker and select Filter Photos by Marker. 

b) Position your mouse on the centre point of the marker, right click your mouse and 

select Add Marker (Figure 14), once you click on Add Marker the menu will disappear 

and you will see a little flag with a label saying “point#” (the number will automatically 

increment to avoid duplicate naming). A flag will also appear next to the thumbnail of 

the photo where you added the marker (Figure 15). 

c) Repeat steps 7a) and 7b) until there is at least 10 images with the same marker, this 

will increase the accuracy of a marker’s location in the 3D model point cloud), you can 

count the number of thumbnails with green flags if in doubt (Figure 15). 

d) Rename each marker (i.e., “point#”) with the corresponding GCP number “target xx” 

(Figure 6).  

e) Verify you have added and renamed missing markers in at least 10 images per marker 

for each of the 15 transects (Figure 15). 

 

Figure 14. Example of how to add marker manually in Metashape (Step 7b). 
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Figure 15. The red arrows showing the flags next to the images that Metashape detected GCP 

markers in.  

After adding a marker, you will see a flag on the image and next to the corresponding 

thumbnail in the Photos windowpane (red arrows – in this example the target has only 3 

projections). 

8) To automatically set the distance between targets and create scalebars, re-run step 5d above 

(load batch script, only ticking process #4 and click the run button). 

9) Align images and optimise alignment by re-loading the batch file from step 5 and run 

processes # 5 and #7. 

10) Reset model region manually by going to Workflow>Model>Transform Region> Reset 

Region. This can be done through the script local on the local machine although it is a good 

opportunity to ensure all images fall within the region by doing it manually. 

11) Check the quality by looking at the number of images aligned and enter the number of 

images and number of images aligned in the Processing Status Spreadsheet (here). The 

spreadsheet will automatically calculate the percent of images aligned. If at least 80% of the 

images have aligned, then continue with the next step. Otherwise stop and make a comment 

in the comment column of the processing status sheet stating: “stopped processing due to 

low quality in alignment, less than 80%”. 

https://teams.microsoft.com/l/file/BEA5D44F-F009-4B16-A26B-81D614B43D4E?tenantId=e054a73b-40dc-4ae3-9fce-60c537aa6fac&fileType=xlsx&objectUrl=https%3A%2F%2Faimsgovau.sharepoint.com%2Fsites%2F3Dmodelling%2FShared%20Documents%2FGeneral%2F3D_Processing_status_monitoring_LTMP_AIMS.xlsx&baseUrl=https%3A%2F%2Faimsgovau.sharepoint.com%2Fsites%2F3Dmodelling&serviceName=teams&threadId=19:393b6870a3e141c98a95a8a291611ba1@thread.tacv2&groupId=851a9282-cdc6-46b7-bb33-d751de57e84d
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12) Assuming alignment was 80% or higher, reload the LTMP process batch script from Step 5 

and tick the boxes for process #9 “Build Dense Cloud”. You will not need to select process 

#8 “Reset region” as this has already been completed manually. 

13) Visually inspect the quality of the Dense Cloud once processing is completed. A good dense 

cloud should resemble Figure 16Figure 17B. Common problems are large holes in the point 

cloud (Figure 16A) and bad alignment of images leading to many scattered points 

(highlighted by the blue rectangle in Figure 17A) outside of the bounding box (highlighted by 

the blue arrow). 

a) Large holes in the Point Cloud are usually due to lack of data acquisition in those areas, 

hence the only way to fix it is to take more images (make a note in the Processing 

Status Spreadsheet and don’t continue processing). 

b) Bad alignment can be addressed by clicking on the Camera Icon   denoted by 

the red arrow in Figure 17B. If it shows cameras outside of the bounding box (denoted 

by the white arrow). Click the Free Form Selection tool   shown in Figure 17C 

and select the cameras that are outside of the bounding box. Right-click on the 

cameras and select “Disable Cameras” shown in Figure 17D and re-build the Dense 

Cloud (Step 12). Re-inspect the Dense Cloud. 

14) If the model is good quality, orientate the view so that it is looking directly down upon the 

reconstruction, see Figure 18, using the Rotate Object tool  (this can also be found in 

Model> Transform Object > Rotate Object). Once completed, reload the batch script 

described in Step 5 and run processes #10 “Export Cameras” and #11 “Export Points”. 
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15) Once the model has been correctly orientated reload the batch script from Step 5 and select 

processes #10 “Export Cameras” and #11 “Export Points”. Before running processes #10 and 

#11, two folders need to be created for Metashape to export the points in to. These two 

folders are:  

\\isilon\3d_lmtp\exports\cameras\[PROGRAM]\[YEAR]\[CRUISE CODE].  

\\isilon\3d_lmtp\exports\pointsXYZ\[PROGRAM]\[YEAR]\[CRUISE CODE]. 

16) The path to export the points and the cameras to need to be edited. To do this, click the Edit 

button in the batch script window and changing the path by double clicking the path box in 

the Edit Job window. 

17) In the Edit Job window, double click the path box, in there the program code, the year code 

and the cruise code need to be entered to reflect the cruise that is being processed.  

 

 

Figure 16. Showing the difference between a poor alignment and a quality alignment. 

Panel "A" shows a point cloud with many holes due to lack of data or bad data acquisition and Panel 

“B” displaying a completed model showing defined edges with very few scattered points outside of 

the bounding box, which is the lines surrounding the reconstruction. 

A 

B 
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Figure 17. An example of an alignment problem in Panel “A” and how to rectify it in the 

proceeding panels. 

Panel “A” showing scattered points within the blue box outside of the bounding box can be an 

indication of an alignment problem as seen in Panel “B” where the Cameras are outside of the 

bounding box. To fix this click on the selecting tool shown in Panel “C”, select the Cameras outside 

of the bounding box, right click and select “Disable Cameras” from the menu shown in panel “D”. 

 

Figure 18. An example of a correctly orientated model. 

Before exporting the cameras and points, it is important to ensure the model is orientated so that 

the observer is looking directly down upon the model. This is to ensure that when the metrics are 

extracted, they are consistent across all models. 
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Important notes and tips:  

• For each step that has “run script” or starts with “export” change the mapped network drive 

letter to the same as your computer if the network drive isilon\3d_ltmp doesn’t map to Z.   

• If images are imported into the project in the field the path to the data will need to be 

changed once back in AIMS so it maps to Isilon. To do this: Right click on an image from a 

chunk. Then select “Change path”. Relocate photos in the Isilon path and click apply to “Entire 

workspace”. Then navigate to where the images are stored (in isilon). Make sure “all file 

formats” are selected and then click on the same image that was originally selected. And 

choose ok.  

• To rotate the model, Model> Transform Object> Rotate Object. This changes the large orb to 

a smaller orb. 

• To re-center the view (if you “lose” the model) right click in the Model window and select 

“Center view. 

• If you are on the AIMS network or VPN, you can monitor the progress of the job by using 

Agisoft’s Network Monitor Tool, simply enter metashape-qmgr.aims.gov.au into the host 

name and use 5840 as the Port (18). 

 

Figure 19. The required network settings to view the progress of jobs on the HPC using the Agisoft Network 

Monitor software 

5.3 Metric Extraction 

Important for the interpretation of the AIMS LTMP 3D metrics is the spatial extent at which they are 

captured. This method uses virtual quadrats placed on hundreds of locations in the model to estimate 

the metrics described in the table below. To account for spatial extent, three quadrat sizes are often 

used in the scripts to generate 3D metrics which is captured in the variable called qsize: 0.1m, 0.2m 

and 0.5m. Spatial resolution is kept constant across quadrat sizes (spatial extents). 
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Table 1. Summary of metrics extracted from The Dense Point Clouds produced by LTMP.  

More details from this method can be found in Friedman A, Pizarro O, Williams SB, Johnson-Roberson M (2012) 

Multi-Scale Measures of Rugosity, Slope and Aspect from Benthic Stereo Image Reconstructions. PLoS ONE 

7(12): e50440. https://doi.org/10.1371/journal.pone.0050440.  

Variable Name (code) Description Ecological interpretation 

Rugosity (rgsty) 

Defines how convoluted the reef substrate 
is, where values equal 1, this metric 
describes a flat terrain and the larger the 
value the more complex or convoluted is 
the substrate. 

The higher substrate rugosity is, the more 
surface there is for benthic biota to 
occupy, this has been related to greater 
food availability, greater diversity and 
greater niche availability for both sessile 
and mobile fauna. 

Terrain Slope (slope) 
Angle, in degrees, of the overall slope of 
the reef within the quadrat. 

 Fitness metrics, such as growth, of 
benthic organisms (i.e. coral recruits) have 
been related to slope incline. For instance, 
coral recruits are found in higher 
abundance on vertical surfaces compared 
to horizontal ones. 

Terrain Aspect (aspect) 

Compass direction that a slope faces, and 
it is measured in radians. This is circular 
metric, so sin and cos functions should 
use to separate eastern from northern 
components. 

Aspect is related to the exposure of a reef 
area to important environmental drivers 
such as water flow and light, which have 
been linked to coral reef community 
structure and function.  

Concavity (concavity) 

Defines the shape of the slope of the reef 
substrate within a quadrat. It is calculated 
by the second order differential of the 
terrain heights (Laplacian operator). 
Convex is positive and concave is 
negative. 

This exploratory metric might influence the 
amount of activity (i.e. bite rates) a reef 
area might be subject to. It might also be 
related to other important ecological 
processes, such refugia from large 
predators. 

Deviance of elevation 
or height (meandevz) 

Measures the variance of heights within 
a quadrat. Measures how much the 
heights in a quadrat vary from the mean or 
the "peakiness" of the substrate in a 
quadrat, the greater the variance the 
"peakier" the reef. It does not account for 
direction. 

The “peakiness” of the substrate has been 
related to the diffused boundary layer, 
which can influence the acidity of the water 
a benthic organism experiences as well as 
nutrient cycling and productivity of the 
system.   

Coefficient of variance 
range of elevations or 
heights (rangezCV) 

This is range between the lowest and 
highest elevation of the reef substrate 
within a quadrat. It is presented as the 
coefficient of variance across the transect. 
It measures how much the heights in a 
quadrat vary from the mean. It does 
account for direction so a positive and a 
negative value don't cancel each other 
out. 

Like the meandevz, the rangedevz also 
represents the “peakiness” of the 
substrate, but across the transect rather 
than across the quadrat. At this spatial 
extent, peakiness of the reef could be 
related to several important ecosystem 
state metrics, such as diversity, coral 
cover and bleaching susceptibility. 

Median of range of 
elevations or heights 
(rangez median)  

The range of heights between the lowest 
and highest elevation of the substrate 
within a quadrat. It is presented as the 
median of these range values across 
a transect. Measures the height at which 
50% of the observations are lower and 
50% are higher - it is a measure of central 
tendency. The higher this value is, the 
higher the number of individual tall 
structures in a transect. 

The number of tall structures in a reef 
influence the detectability of predators as 
well as the potential escape routes a prey 
might access. Hence, this metric might 
influence mobile organism behaviour, 
amongst other important ecological 
processes. 

 

https://doi.org/10.1371/journal.pone.0050440
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1) Calculate structural complexity metrics described above from Dense Point Clouds 

a) Launch HPC interactive. Make sure you are connected to the VPN (if working 

remotely). Launch an internet browser and type the following address: https://hpc-

interactive.aims.gov.au:3443/  

b) Launch a GNOME session 

c) From the Terminal: 

i) Pull the git repository to a folder called "gits" in your desktop by typing “cd 

/export/home/l-p/[YOUR USERNAME]/Desktop/gits/gits pull 

https://github.com/AIMS/reef3D.git ” 

ii) Load the Matlab module by typing “module load MATLAB/R2018a” 

iii) Change directory to script folder by typing “cd /export/home/l-p/[YOUR 

USERNAME]/Desktop/gits/reef3D/data_analyses” 

iv) Run function to calculate structural complexity metrics by typing “matlab -

nodisplay -nodesktop -nosplash -r "summary_transect [PATH_TO_POINTS] 

[PATH_TO_CAMERAS] [PATH_TO_SCRIPTS] [PATH_TO_EXPORT_FOLDER]" 

 

  

WHERE:    

[PATH_TO_POINTS] is the directory path to the point clouds folder for the specific cruise code 

        (e.g., '/mnt/isilon/3d_ltmp/exports/pointsXYZ/RM/201819/OR/') 

[PATH_TO_CAMERAS] is the directory path containing the camera pose for the specific cruise 

code 

        (e.g., '/mnt/isilon/3d_ltmp/exports/cameras/RM/201819/OR/') 

 [PATH_TO_SCRIPTS] is the directory path where the scripts are contained 

        (e.g., '/export/home/l-p/mgonzale/Desktop/gits/reef3D/') 

 [PATH_TO_EXPORT_FOLDER] is the folder where to export the results. 

        (e.g., '/mnt/isilon/3d_ltmp/exports') 

Example code for step 1)c)iv): 

matlab -nodisplay -nodesktop -nosplash -r "summary_transect 

'/mnt/isilon/3d_ltmp/exports/pointsXYZ/RM/201819/OR/'  

'/mnt/isilon/3d_ltmp/exports/cameras/RM/201819/OR/' '/export/home/l-

p/mgonzale/Desktop/gits/reef3D/'  '/mnt/isilon/3d_ltmp/exports'" 

https://hpc-interactive.aims.gov.au:3443/
https://hpc-interactive.aims.gov.au:3443/
https://github.com/AIMS/reef3D.git
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